LAZYCAM MANUAL 7/16/2009 REV:0

LazyCam will import a number of different profiles drawn to scale, in different file
formats, and produce the gcode necessary to make the part. The following are available:
Mill — Contour / pocket a profile in a spiral fashion with CW / CCW motion, on the left
or right side of the profile based on a defined tool and it’s associated parameters.
- Pocket a profile in a ZigZag fashion based on a defined tool and it’s associated
parameters.
- Mill a profile with or without offsets based on a defined tool and it’s associated
parameters.
- Provide gcode for the drilling of holes into a piece and when used along with one
of the Wizards will allow for canned drilling cycles.
MILL TEXT - provides for placing of your choice of text on a piece and allows for a
machining the text.
LATHE ( TURN )- Provides for the creation of lathe pathing to machine a profile or
generate a profile cut as defined by the tool parameters.
FOAM 2D AND 3D - ? I don’t know / never used it.

LazyCam can be loaded by opening Mach and clicking on LazyCam.....

You could also create a short cut and work standalone but recommend that you invoke it
from MACH since you can post directly to MACH and may want to go back and forth
between the programs.

ﬁ Config  Function Cfg's

Load G-Code
Lazwarn ...
lose File(s)
E:xik

e e e gt

|- A0 Pt (T L s T L T L f

The following tabs are available at the top of the screen.

” File Setup Tools Yiew Help Oubput
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The File button provides for importing different file types, loading a gcode file which is

currently in Mach3. You can also save a LazyCam project, close a file or exit LazyCam.
Fle Setup Tools Wiew Help  Output
Mew.,
Cpen Yeckor file { DRF, WHF, HPGL, PLT...)
i Cpen Image File{ Jpg Bmp Png..ect..)
Load Current Mach3 file

T T

Recent: File

Open LCam Project ...
Save LCam project As..
Sawve LCam Project. ..
Close File. .

Exit

LazyCam provides for setting up posting and loading options via the Setup tab.

Setup  Tools  Yiew Help Owtput
Paosting Options. ..

Loading Option. . AutoClean Settings Ima

1

The posting options flyout provides for a number of options. You can have LC
(LazyCam) autoname your file, put additional information in the beginning of the gcode
to be posted, provide for coolant code, send the file to Mach, assign line numbers in
increments of your choice. Just check what options you want and click OK.

B
GCode File option:
[cAMach3iGEodet Browse

Set Post Processor| _Set to Default |

¥ AutoName and Save
[ Put Time and Date as comments in output e “cTi*e post |Defau|‘r

Generic G-Code output Options
v Use G41/G42 on Leadin outputs . [ depending on leadin directions)
™ Incrermental 1)'s. Will use appropriate control words to set Mach3
I Coolant
¥ Send File to Mach3 when posted

Plunge Clearance 0.0000

Line Number Increment: |3
¥ Dont ask me again
Iwill use File/Post options if | wish to change anything Cancel | QK |

The Loading options flyout provides for some automation as it relates to the file you are
importing into LC. | would suggest using a Version 12 DXF CAD generated file of your
profile.
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il AutoClean Filters x|

The following Filters are applied when you press the Autoclean Icon on the Functions Bar

7/16/2009 REV:0

- AutoClean
v Optimise Drawing. This will recrder elements for an optimal path
I© Relayer -—----- This will apply the RELAYER function. This will make new layers-
"Insides(0-x) Layer" and "Outsides Layer". The inside layers will include all objects
which are contained within the outside objects and therefore need to be cut
first. These layers will be automatically created.
This option is used, for example, for cutting letters and such and allows for
quick reverse offsetting where the outside is offset outwards, and the inside
is offset inwards.
™ Automatically Add inside and outside Leadins.
Lead-in Size: 1.0000 units. Tool Diameter or lead length

Or... W Use 10% of Chain size..
v As Drawn - This maintains the Origin at 0,0, othenwise minx,miny is used.

~Misc

Foam Allowance

I 0 Units

Connection Line Tol.
Usedin Optomise

" HPGL in Metric

01

~Load
‘ Default Location of Mach3 Browse |

[Critdach3

v Remove Duplicated Lines(Cnly applies at file load time.)
v lgnore Text Entities

The Tools Tab allows for a number of different options to modify the profile and some of

the more commonly used ones are also located o the left side of the screen.

Tools

 AutoClesn

ZoomBox..
i Remove Redundant Entities
. Minmize Geometry
" Fillet Carners

Remove Chain

Reesat Origin ko Min.

Scale Drawing

Move Chain

Set Layer Depth

Drill Circles

Remove Circles

Ratate Drawing

Optimize drawing

Turn off all Leadins

Relayer File

Clear Selections

jgw Help  Output

g Mach3 Load | H‘ Save *.LCAM

. Ooops Project Info .Pust Coc
o

MClean

Reset Origin

W shift Drw
Mrem. Objects
Wiscale

MHove Chain
M set Depth

W oril 5el Circles
Moril Rad Circles
WRotate

M optimise
WLeads off
Mrem. Points

SOME OF THE MORE
COMMONLY USED TOOLS
IARE DUPLICATED ON THIS
SIDE OF THE SCREEN

Relayer

Mlizel in Box

Mpesel Al

MRapids anjoff

I Zaom Box B

[ Select Inside

Pockets Offsets Foam 20 Mkt
Msingle/Multiple
3D Tun Text Assist

The View Tab allows for adding or removing displayed information as highlighted

below.
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I Lazyram 10l =l
File Setup Tools | Wiew Help  Cukput

?i% Open * LCAM v Status Bar maqge File MS‘ Machs Load ‘ u‘ Sawe * LCAM . Danps ‘
w Info Bar O] BMcean
Ellu MachFile | ¥ 129dle Rapid display MReset Crigin
= outsipe W shift Drw
E Chain#1 Mrem. Objects
[+ Chain#0 B
BMMove Chain
M set Depth
0 Dvill Sel Circles
PROPERTIES BAR MCrill Rad Circles
M Rotate
M optimise
W Leads OFf
MRem, Points
TOGGLERAPIDTOBE |8~ 0
Project Packets I F Offzets I Faan 20 DISPLAYED ON OR OFF .—
Foam 30 J Tumn J Tenut Azt .Zoo.m Box
LazvCam Startup.. |=]
19:02:22 -—- -- Loading Mach3 file..
19:02:22 --—- -- Attaching to Mach3.
19:02:22 --—- -- Mach3 Found.
19:02:22 --—- -- Loading complete. .
19:21:13 -—- -- Laading Mach 3 file..'h\ INFOBAR
19:21:13 --- -- Attaching to Mach3.
19:21:13 --- -- Mach3 Found.
19:21:13 --- -- Loading complete. .
M| 4| » |\ Project { Extents ) Layers & Chains & Entities § JLI _il_l
[ETATUS BAR | T m |

There is no LC help other than the thread on the web site, and what is written here, and
the videos. Clicking the Help button will show you what version of LC you are using.

Help  Cutput

About LazyCam x|
i ‘ LazyCam Yerzion 3.00.2 ok |

A.Fenerty / B. Barker
Copyright [C] ArtSoft 2007

Pro Werzion : RICHARD WALITES

The Output tab allows for posting gcode to MACH3. Note that how and what will be
posted is influenced by what you checked off in the Setup Tab.
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Dukpuk

. b o | Ha. | am = |
M3%IThe Qutput Tab allows you to postcode. You can also post

[ ] x| code using the button
I

There are a number of commonly used functions which are available via buttons and
duplicate some of the Tab pull down commands.

Clicking open *.LCAM will invoke the typical windows screen for locating where you
saved the file and the same goes for opening a DXF file, image file.

~u

8 Open*.lCaM  [& Open DiF & image File M3‘ Mach3 Load ‘ nlSave * LCAM ‘ |

2

Laak in: I 9 My Computer j & e B2~

&3‘;‘; Floppy {A:)
(% Local Disk {C:)

| L CD-RWW Drive (D1
| L DYD Drive (E:)

% Local Disk (%)

|==) Shared Documents
Desktop |- Administrator's Documents
My Documents
-
.
Iy Computer
File name: :':_Iu::.arr j Open I
Files of type: ILCam Files [*.lzam) j Cancel |

[ Open as read-orly

o )

Clicking the Mach3 Load button will load the gcode which is currently in MACH3
if one was loaded.

MS‘ Mach3 Load

‘ E; Save *.LCAM

. Coaps H Project .Ir
(L1

| J=I]

‘oam 20

Agzist

Clicking the Save *.LCAM button will save you current project as it currently is and can
be reloaded using the other button or File tab.
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The Ooops button will undo you last command, the Project and Info Button turn the
associated displayed information on or off.

I‘ °000D5 ‘ E Project - Info

-

The Info box on the screen provides detailed information relative to your work and is
broken down by category via 5 tabs. Clicking on the table will show / provide additional
dialogue for relative information or input.

The project tab should be monitored to see LC’s activity and provides command status.

U 1B 38 === == 2L odiEL

20:16:46 --- —- Cleaning Drawing.

20:16:46 --- —- Optimising. .

20:16:46 --- —- Finding MNodes in 20 entities.
20:16:46 --- —- Total Chains 1

20:16:46 --- —- Ordering....

20:16:46 --- —- Optimising complete..
20:16:49 --- —- Project Bawved

20:16:49 --- —- Optimising..

20:16:49 --- —- Finding MNodes in 20 entities.
20:16:49 --- -—- Total Chains 1

20:16:49 --- —- Ordering....

20:16:49 --- —- Optimising complete..

M | {l bl HRPIDiEC[I{ Extents & Layers L Chains } Entities [ Jil

The extents tab will show you min / max values for the profile, how many chains, entities
, etc there are. One important one is the connection tolerance as this relates to how the
drawing of your profile was done and how LC will connect the lines etc.

x|
el IrmvgaryS ICnnnchDn Tal,:0,100000 units
|I-E..3999 |Max><: 0.0001 units |# of Chains: 1
IMinK: 0.0000 units IMax‘f: 3.6800 units It.;.ta| Entities: 20
| MinZ: 0,0000 units | MaxZ: 0,0000 units | %1-7, 0544 Yi-1,2696

The Layer tab allows for tool creation and picking a tool and how it should be applied to
a layer. Then you also have choice of how he tool will travel when cutting.
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Layer ~Tool ~Cut
L;ayer Name Marne Rapid Height CanCyele Type
JARTMASTER Mo Tool
[ I = Tec [ Rapid Height: 1,0000 units I Wocyee x|
[ Layer Enabled Tool ISplndIe SPeed ii‘lunge FEEdI Cut Start
f i 0 RFM G0, 00 units /mir
Layer Leadin Settings | [ Cut Start: 0.0000 units
Per Pass FeedRate
Cut Crder Cut Depth
oot Ordler # 1 I 900, 0000 Uik I 60,00 wniiks fmir
Tool Mumber | CutDepth:0.0000 units gl
I Foam Cwell: 0,0 Seconds I Tool Mumber: £ 3end ko Al layers Set Layer | et &ll Lavers

M| 4| »| M Froject ) Ewtents 4 Layers { Chans § Entities

=

The Chain tab provides information on a particular chain.

=l
Ol | —Extents of Chain

Max % |0.0001

Min ' |n Mare ¥ |3.58

Contained by chain #

Ertities in Chain

o
—

Closed Chain W

Twpe I 1 LeadIn Sekting |
Tab |

|-1—
£0
1]

Crder in Layer

M| 4| » | M} Project } Estents § Layers } Chains § Entities {

R

You can pick a particular entity and see it’s related information.

=
d Entity Type: [LINE
startx |4 Endx [0 Centers [0 Length IW
starty  [3.58 Endy [3.2364 Centert [0
StartZ [o Endz |0 CenterZ |.;.—
Skarkd IEI Enda IEI Centerd ID—

¥ cCurrently Selected

[ Tab

M| 4| »| M} Project | Extentz § Layers § Chains 4 Entities |

14

So much for the Tabs, Buttons, and screens and sorry for no definitions for each
command as | am not going to write a book! Just follow the example which is next.
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CONFIGURATION
How you have Mach3 Mill or Lathe configured will affect posting of the gcode. Here is
just some logic to look at that relates to Lathe but makes the point.

[POST PROCESSOR | [MACH CONFIGURATION _|—| PROGRAM ARC
[

o - MOTION
PROGRARM
L) L
INITIALIZATION STRING
G0 G115, 3L VEIES 10 GHUGIL G G
G50 G551 G55 G54 [ FFSETS) 66 L6
CH0 CED] GO
TURN OPTIONS
RADIUS
DIAMETER
EEVERSED ARC'S I FROMT POST
LATHE TYTE
FEOMT TOOL POST
EEARTOOLEOST
p| CURRENTX#& ZLOCATION
o FINAL PROGEAM
G CODE
ARC MOTION
02 ABSOLUTE
(02 ITCREMENTAL
0302 FLADTUIS Ei+ VALUE)
Ei- VALUE)
302 ABSOLITTE
0302 N CREMEHTAL
02 FLADIUS Ri+ VALUE)
Ei- VALUE)
LAZYCARM
EADIUS
DLAMETEE | ™
5T
LAZTURN
RADTITS Wl
DIAMETEE
TURMN WIZAERDS
{ CODE OUTEUT EASED
OM COMFIGURATION)
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MILLING A PROFILE

Lets start with the CAD drawing of the profile. This particular one is a plate that needs to
be machined out.. Additionally it has a big hole which needs to be machine out and there
are holes that need to be drilled. I am going to do this step by step as an example. It will
show you how to contour a piece and drill the holes. It’s probably represents much of
what a typical user of LC would want to do.

i

EﬂTE"‘ 3]
© O <
o O 2
] ]

First of all I don’t like the idea of having the origin of the part as shown above. On the
mill I prefer to work from the lower left corner of the piece since all gcode and
coordinates will be positive. Here is the updated CAD.

i p
oA o |[PRILL HOLES |
MACHINE A
HOLE
& 0 )
O )
=

Now if you are wondering about DXF files and how to draw them | would suggest that
you take a look at the LAZYTURN MANUAL in members docs as it has an appendix on
dxf files and drawing problems which although relate to the lathe are relevant.

So | save the file in CAD as version 12 ( other version work but recommend 12)

A HEIR. d j

File narme:

Files of type: | utoCAD R12/LT2 DXF [*.dsf) |

Page 9 of 22



LAZYCAM MANUAL 7/16/2009 REV:0

LC SETUP:

Note that | want to optimize the drawing and not base it on how it may have been drawn.
Using a small connection line tolerance ( | draw accurately! ) and want to leave the
drawing as drawn with it’s origin at X& Y = 0,0. There is no text in the drawing and

should not contain any extra / duplicated lines.
]

The following Filters are applied when you press the Autoclean lcon on the Functions Bar

~AutoClean ~Misc.
—* Iv Optimise Drawing. This will recrder elements for an optimal path Foarm Allowance
™ Relayer ------- This will apply the RELAYER function. This will make new layers- loi U
nits

"Insides(0-x) Layer" and "Outsides Layer". The inside layers will include all objects

which are contained within the outside objects and therefore need to be cut Cannection Line Tol

Used in Optomise

first. These layers will be automatically created. W
This option is used, for example, for cutting letters and such and allows for
quick reverse offsetting where the outside is offset outwards, and the inside I HEGL in Metric

is offset inwards.
[~ Automatically Add inside and outside Leadins.
Leadn Size 10000 unts. Tool Diameter or lead length

Or... ¥ Use 10% of Chain size ..
T—* ¥ As Drawn - This maintains the Origin at 0.0, othenvise minxminy is used.

rLoad

Diefault Location of Mach3 Browse
Chdach3

—* [v Remove Duplicated Lines(Cnly applies at file load time )
— ¥ lanore Text Entities

Here are posting selections. We will try incremental 1J°s

Posting Dptions x|

- GCode File options
[C:\Mach3iG Codel Browse |

Set Post Processor|  Set to Default |
Active post: IDefaUIT

L AutoMame and Save..
—F Put Tirme and Date as comnments in output file

~Generic G-Code output Options
— v Use G41/G42 on Leadin outputs . { depending on leadin directions)
I |ncremental I1's. Will use appropriate control words to set Mach3.

™ Coolant
— ¥ Send File to Mach3 when posted.

Flunge Clearance 0.0000

Line Number Increment: |1 0|._

I Dont ask me again
| will use FilefPost options if | wish to change anything.. Cancel QK

Page 10 of 22



LAZYCAM MANUAL

Here is the MACH3 Mill configuration.
IVMu:utinn M ode

" Constant Yelocity % Exact Stop
Distance Mode——— — |J kMode
& pbsolute © e | € Abzolute % |nc
Active Plane of Maovement
o Wy CyE O K-Z_‘

[ P R |

) N B3 Bl S i Sign Bl |

Import the DXF file into LC.
(& Open DEF E Imane File MS‘ Mach3 Load

A G2 and &3
AMACH
Local Disk, (%)

Mach3 06012009

THREADIMG SLIMMARY

7 A MACH AMND CHC

Dieskltop Z & MEW MACH INSTALLstick
7 DISK 18
fidlasa HoR

Tell mach that it will be a mill session. Click the MILL box.

ﬁ Plasma

Import Session Type

il

Turn

Foam
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LC imports the file and here is what | get.

= [ ARA_HCIR
L

1[4 agu

]
[ |
(|
]
|
|
| ]
(|
|
|
|
]
| ]
|
| ]
L]
[

els Dffsets Foam 2D
[ Text Assist

I only want to machine the outside plate so | am going to delete the entities | don’t want.
Click the Single / Multiple tool, the click each entity you don’t want as shown below.

M ove Chain
Msct Depth

I Drill Sel Circles
M Cvill Rad Circles
MR.ctate

M Cptimise

¥ Leads off
Mrem. Points

Relayver

[ Zoom Box
M sel in Box

[ 5elect Inside

BDesel al
MF =pids onfoff
M Chain-Ent Sel

SELECT THE ITEMS NOT WANTED BY Single/Multiple
CLICKING ON THEM

Place the mouse on one of the entities, right click the mouse and you will get the fly out
with the menu item to delete the selected items, click on it and when you get a prompt
say yes.
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RIGHT CLICK MOUSE AND
OU WILL GET THE FLYQUT

AND CLICK DELETE

SELECTED ITEMS

Delete Selected Items
Jaim Twa Selected Primtives

Save Chain as Shapefile
Load shape File ko Screen
Remove Shapes

LC deletes the items as shown below.

ilm = --

We still need to do some cleaning so click clean and the optimize tools.
| Mclean r

Mset Depth
W orill gel Circles
Mrril Rad Circles

sin-Ent Sel
W SinglejMultipls
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If you click on the chain#0 in the project info all of the entities associated with that chain
are highlighted in the screen area. Additionally I clicked on the rapid on/off tool and the
rapid is no longer shown.

. - | |

= ana_How
o

=i aqu

@] Entity#3
(@] Entitys4
(®] Entity#s
] Entity#6
) Entity#7
] Entity#s
8] Entity#9

[ Msing!

Lets create a tool for cutting out the profile.

Click the layers tab, click tool, fill in the information, click create, give the tool a name
click ok, and then again ok data flyout as shown below.

- | i |

|10l Selection.
B Mew Tool Name? x| Create | Delete Tool

14 EMD MILL | Tool Dia:0 2500 units
| Post as Tool #1
[ le

I FeedRate:40.00 units

Cancel | |Plunga Speed:40.0000 units

I Max Cuk pfpass:0,1000 units

| Spindle :100 RPM

Update Toal I

1 Taol Cut
‘et Name e Rapid Height

U ¥ [
! 1 A [neo0 Rapid Height: 1,0000 uriks

Layer Enabled [} Spindle SPeed Flunge Feed Cut Start

_ayer Leadin Settingsh I O RPN I 80,00 Ltsfmir Cut Start: 0,0000 units
Per Pass FeedRate

Order

't I— Cut Depth

“Order # 1 993,0000 unit: 60,00 uniks/mir P .

' 1 Toal Number CutDepth:0.0000 units g

3m Dwel: 0.0 Seconds |‘ ITooI MNumber: © Send ko All layers Set Layer I Set All Layers
1
¥

M\, Project } Exterts } Layers [ Chains } Entties | I i
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Notice the data has changed in the layers tab, click Send to all layers box.

— Tool

Marme
| 1/4 END MILL
Tool Spindle SPeed Plunge Feed
| 100 RPM | 40.00 uris{mir
Per Pass FeedRate
— | ||:|.1|:u:u:| units W
Tool Mumnber

I Tool Murnber: 1

Click the project tab and notice that the optimizing that we did before is complete and
that the tool data was sent to all the layers.

Sl .2 7T T JL R o Y Y B O Y e

21:46:50 --- —-- Ordering....
21:46:50 --- —-- Optimising complete. K f

22:00:43 --- —- Tool Data sent to all lavers.

M| 4| »| M) Project { Estents } Layers } Chains } Entites J KN}

We defined a tool to cut with but now we need to tell LC how we want the tool to travel.
This is done by providing the cut data as shown below. Note that we will be doing 10
cuts since our tool per pass was set for .1” and we are going to cut to a depth of 1”.
Click set layer and set all layers.

S Cuk
Rapid Height Canzycle Type
[ Rapid Height: 1.0000 units | NoCyde  ~]
Cuk Skark
| Cur Start: 0.1000 unit MINUS
L art: L, anics
ALUE
Zut Depth
| CutDepth:-1.0000 units
Setlayer ||t etAlllayers
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Move your mouse into the graphics area, then hold the scroll wheel and move the mouse
to rotate the view, which shows the multiple passes, as shown below.
L

HC
e
[
ML
|3
R
H:
M
s
HC
[
!

Double clicking in the graphics area returns the graphic to plan view.

DOUBLE CLICK

i
Click POST code button and the code is sent to MACHS3, click ok in the posting box.

“Elle Setup Tools Wiew Help Output

nl Save *.LCAM

o Ooops H Pro]ect .InFo
1|

‘2] Open*.LCAM [ Open DXF [ 1mage File Ma" Mach3 Load

I | x|

Clean

=L Aaa_HCIR MReset Origin
g0 Mshift Drw
=il AQu MRem, Objects
- chaingo
§ Wscale
- [@] Entity#o
B Entity#1 Mrove Chain
48] Entity#2 Mset Depth
-8l Entity#3 ol Sel Circles
8- Entitys4 il Rad Circles
[&8) entityas Wratate
-4} Entity#6 ™
8] Entity#7 (Ol
| & Entity#s WlLeads Off
L. 4] Entity#o Mrenm, Points
Relayer
¥ zoom Box
W5l in Box
[ 5elect Insid
Moesel Al
[ ! : C:iMach3iGCodelaAs_HCIR tap file created. MR 2pids onjoff
M Chain-Ent Sel
WsinglejMultipls
Project Pockets Dffsets Foam 2D
Tun Test Assist
21:46:50 --- -- Optimising complete.. -]
22:00:43 --- - Tool Data sent to all layers.
22:09:22 --- -- Height Data sent to all lavers.
22:16:40 --- —— Posting File.

L 2Er1R41 - Bttaching to Machi.‘i——__
1 22:16:41 --- - Mach3 Found.(.___ —
S || 4| » | Ml Project [ Extents ), Layers § Chains § Enfities § 1= 2
Fimdis
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Minimize LazyCam window and then you will see the posted code in MACH3 Mill.

Mach3 CNC Controller ==

File Config Funckion Cfg's Wiew Wizards Operator  Plugln Control  Help

Program Run (Alt-1) | MDI{AH-2) | Tool Path (a4} | Offsets (Alt-5)] settings (al-6) | Di o (ART) | Will-=315 &1 610 617 640 620 580 5084 654 640 G20 651 687

+0.0000
+0.0000

+0.000df || _+7 7000 |
+0.0000 ||__+3.6800

+0.0000 -1.0000 +1.0000 E
M10 (File Marme = A8 HCIR on Thursday, July 16, 2009) | 4 | +0.0000 +0.0000
MZ0 (Default Mill Past)
N3O G311 +0.0000 |[¢ I f
M40 W& M3 T ——

M50 ME T1TOOL Change 1/4 EMD MILL)
MB0 543 H1

N70 GO Z1.0000

ME0 M3 S100

Simulate Pregram Run __J _ Run From Here
Estimated Program Run Time 0:00:00 Ug

P [ B
e

‘ Reset G-Codes | M-Codes |

History | Clear ﬁtatus:l TOOL Change 144 END MILL PrﬂfilE!lSS_ ATLAS MILL

Now wasn’t that easy. Only one problem with the above, it will cut the profile out exactly
as drawn and is not offset to outside of the profile. Now you can get tricky and scale the
X &Y in Mach3 but we will go back redo the it LC.
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MILLING SOME TEXT

Here is a recent posting on how to mill some text, quick and dirty but available as a
crude example:

1.0pen the DXF file.

JEiIe Setup Tools Wiew Help ©Output

Y

2) open*LCAM [ Open DWF
*

& ImageFie M3‘ Mach3 Load ‘ ul Save *,LCAM ‘ . Qoc

e
@ aagaryl
@ cigar TopBushing

AUTOCAD TO GUODE G
Dalphin_post From artsoft
fémb

geodezdxf @ rreegarys
hiaman ] SECT_S_HCIR
POST ARC MOTION

2, Click Mill
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4.Now go and select each of the text parts.

WL Had Circles
MRatate
.Optimise
[Leads oFf
MR, Poirks
Relayer

[ Zoom Box
M =elin Box

[ select Inside

MDesel Al

MR apids onfoff

M Chain-Ent Sel

M single/Multiple

5.0pen the Layers Tab and click Tool, fill in the data for the tool, click Create, then click
OK. Select the tool and click OK, then click Send to All Layers. Notice | set the per pass
cut depth to .005”.
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& e
Tool Selection.. |
3(8 endmil Create Delete Tool | d nl 5
35 end mill
again
drill
| Tl Dia:0.0100 units

I Post as Tool #1

| FeedRate:20.00 units

I Flunge Speed: 20,0000 units

I Max Cut pfpass:0.0050 units

| spindle: :100 RPM
Update Tool |

Cancel |

Faam 200 |J o | Z W R

1|
=/} Layer B
Layer Mams

I o Iengrave

¥ Layer Enabled Spindle SPeed Plunge Feed

Layer Leadin Settings | | 100 RPHM | 20.00 unitsmic
FeedRate

Per Pass

izl

Marme

4
— M"
= =N
o

fral

o Bl ' Ry |

Cuk Crder e
I Cuk Order # 0 : units I 20,00 uriits/mir .
Toaol Mumber

| Faam Dwell: 0.0 Seconds |Too| Murber: 1 Send to All lavers |

6. Now fill the data for how you want to cut the text.In this case it’s a single pass. The cut
depth pass should be negative and not positive.
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Cuk
ﬁ R.apid Height Cancyle Tvpe
I MoCycle vI

| Rapid Height: 0.1000 units

=0 Cuk Start
aiks/mir
| Cut Start: 0,0000 units
— Zuk Depth
aiks/mir

| CutDepthi0.0050 rits gl
Al layers Set Layer | Set all Layers |

7. Click Post Code ( note that there are some settings which you can select for posting
code under the Setup Tab). It creates the file so click OK.
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MS‘ Mach3 Load ‘ nl Save * LCAM ° Coops H Project ‘ InFo
81

Mreset Crrigin

M shift Dro
Mrem. Objects
Mscale I
MMove Chain - W
M set Depth
il Sel Circles
M Cvil Rad Circles
Mirotate
.Optimise
[WLeads OFf

= e, ot

Relayer

! E C:Mach3\GCodelGrafikal 1.kap file created.

[ Zoom Box
Mzl in Box

W select Inside

Bl

8. Go out of LazyCam or minimize, you may also want to save the file and Lazycam as
an .LCAM for later retrieval. Here is the file posted into MACH.

Program an MDI mw Tool Path M Offsets !ﬂﬂ Settings mﬂ Diagnostics mm Mill->G15 G1 G0 317 540 G20 690 534 654 643 629 GE1 597

ii +0.0000
-198.0854 J|_+85.925
_+Q.Q.QQQ.I +0 0000 || +295.3561
+0 QQQQ' +0.005 +0.1001

N5 (File Name = Grafikal on Tuesday, July 14, 2009) +0.000 +0.0001
N10 (Default Mill Post)
N15 G301
120 W5 M9
N25 I T1(TOOL Change endrave)
N30 G43 H1
N35 GO 70,1000
N40 M3 5100 ~|
Simulate Program Run__ | [ Run From Here |
Estimated Program Run Time 0:00:00:0
—

| [
| GCades | M-Codes |

9. You may need to have a license for LazyCam as since the number of lines are
restricted without a license.
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